How to Configure Integration between SAP ERP and SAP Hybris Cloud for Customer using SAP Process Integration
Copyright

© 2015 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP SE or an SAP affiliate company.

SAP and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP SE (or an SAP affiliate company) in Germany and other countries. Please see http://global.sap.com/corporate-en/legal/copyright/index.epx#trademark for additional trademark information and notices.

Some software products marketed by SAP SE and its distributors contain proprietary software components of other software vendors.

National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for informational purposes only, without representation or warranty of any kind, and SAP SE or its affiliated companies shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP SE or SAP affiliate company products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.

In particular, SAP SE or its affiliated companies have no obligation to pursue any course of business outlined in this document or any related presentation, or to develop or release any functionality mentioned therein. This document, or any related presentation, and SAP SE’s or its affiliated companies’ strategy and possible future developments, products, and/or platform directions and functionality are all subject to change and may be changed by SAP SE or its affiliated companies at any time for any reason without notice. The information in this document is not a commitment, promise, or legal obligation to deliver any material, code, or functionality. All forward-looking statements are subject to various risks and uncertainties that could cause actual results to differ materially from expectations. Readers are cautioned not to place undue reliance on these forward-looking statements, which speak only as of their dates, and they should not be relied upon in making purchasing decisions.
# Content

1. **Introduction** ........................................................................................................... 5
2. **Connect Phase: Check and Prepare SAP ERP System** ........................................... 6
   2.1 ERP Software Components .................................................................................. 6
   2.2 Business Configuration Sets .............................................................................. 10
   2.3 RFC Destination to PI ....................................................................................... 11
   2.4 RFC Destination to PI (IDOC_AAE Adapter) ....................................................... 12
   2.5 Create SAP ERP User ....................................................................................... 13
3. **Connect Phase: Check and Prepare PI System** ..................................................... 15
   3.1 Access PI system ............................................................................................... 15
   3.2 Create SLD Configuration ................................................................................ 15
   3.2.1 Create Business System in SLD for SAP ERP .............................................. 15
   3.2.2 Create Technical and Business System in SLD for SAP Hybris Cloud for Customer .... 18
   3.3 ERP PI Software Components .......................................................................... 22
   3.4 RFC Destination to SAP On-Premise ................................................................. 24
   3.5 PI Port Configuration ....................................................................................... 24
   3.6 RFC Destination to SAP On-Premise (IDOC_AAE adapter) .................................. 25
   3.7 Resource Adapter (InboundRA) Configuration for IDOC_AAE Adapter .............. 26
   3.8 Import TPZ Package in ESR ........................................................................... 27
   3.9 Import Business System .................................................................................. 29
   3.10 ALEAUD CHECK ......................................................................................... 31
4. **Set Up Secure Connection Between ERP-PI-Cloud Systems** ............................... 33
   4.1 Supported Certification Authorities (PI Integration) ............................................ 33
   4.2 Check End-to-End Connectivity ..................................................................... 35
5. **Configure Phase: Configure Integration in Cloud Solution** ............................... 37
   5.1 Activate SAP ERP Integration in Scoping ....................................................... 37
   5.2 Setup Communication System ....................................................................... 39
   5.3 Configure Communication Arrangements ..................................................... 41
   5.3.1 Mass Configuration of Communication Arrangements .................................. 41
   5.3.2 Configure Communication Arrangements for Outbound Communication .... 45
   5.4 Export the Root Certificate ............................................................................ 49
   5.5 Determine Short Tenant ID ............................................................................ 52
   5.6 Optional: Maintain ERP Number Ranges ....................................................... 53
   5.7 Perform Code List Mapping ........................................................................... 55
   5.7.1 Manually map the Code Lists ................................................................... 55
   5.7.2 Automated Configuration of Code List Mapping ......................................... 57
   5.8 Create ID Mapping ....................................................................................... 62
   5.8.1 ID Mapping Using the Microsoft Excel Template ....................................... 64
   5.9 Optional: Handling of Inconsistent Address Data ........................................... 67
6. **Configure Phase: Configure Integration in SAP ERP** ........................................ 69
   6.1 Add an Authorization Profile for a Role ......................................................... 69
   6.2 SAP Customizing Implementation Guide in the ERP system ............................ 70
   6.3 Automatically Generate Integration Settings for Data Exchange .................... 71
   6.4 Area Menu ..................................................................................................... 76
7. **Configure Phase: Configure ERP Integration in PI System** ................................ 78
7.1 Create a Key Storage View and load certificate .................................................. 78
7.2 Import the Root Certificate ............................................................................. 79
7.3 Create ERP Configuration Scenarios ................................................................. 80
    7.3.1 ABAP Based PI Stack ............................................................................. 80
    7.3.2 JAVA Based PI Stack ........................................................................ 82
7.4 Configure Interfaces ......................................................................................... 84
    7.4.1 Assign the Business Systems to Each Components ...................................... 84
    7.4.2 Create the Communication Channels and Assign them to Sender and Receiver Business System Components .......................................................... 86
    7.4.3 Generate Process Integration Configuration Objects ..................................... 91
    7.4.4 Configure ERP_IDOC_receive Communication Channel with correct Port and RFC Destination ........................................................................... 93
7.5 Maintain Communication Channel for ERP Integration ................................. 95
7.6 Adjust Routing Conditions for ERP Integration ................................................. 97
7.7 Maintain Value Mapping between Cloud and ERP in PI .................................. 99
7.8 Activate Changes in Change List ..................................................................... 100
8 Data Load Phase: Perform Initial Data Load ..................................................... 104
9 Monitor Phase: Monitor Message Flow Across Systems .................................... 106
10 Appendix .......................................................................................................... 107
    10.1 Register Service for IDoc Inbound ................................................................. 107
    10.2 Maintain Requirement Routine...................................................................... 107
    10.3 Maintain Output Determination procedure .................................................. 109
    10.4 Maintain Output Record ............................................................................. 110
    10.5 Activate Event Linkage ............................................................................... 111
    10.6 Maintain Endpoints for Services ................................................................. 112
    10.7 Activate Change Pointers for IDOCs ............................................................ 113
    10.8 Work Ticket Integration ............................................................................ 115
    10.9 Configuration to replicate international customer names and addresses ........ 115
    10.10 Configuration to send attachments from SAP ERP to SAP Hybris Cloud for Customer ..................... 117
    10.11 Configuration to send attachments from SAP Hybris Cloud for Customer to SAP ERP .......... 121
    10.12 Define Logical System ............................................................................. 124
    10.13 Define Number Intervals .......................................................................... 126
    10.13.1 Define Number Intervals for Customer Contacts .................................. 126
    10.13.2 Define Number Intervals for Customers ................................................ 126
    10.14 Configuration of Communication Arrangements ....................................... 127
    10.15 Configure MS Outlook/ Lotus Notes (Optional) .......................................... 130
    10.16 Customize Business role with Forecast and Reports (Optional) .................... 131
    10.17 Configure Single Sign-On (Optional) ......................................................... 131

© 2016 SAP SE. All rights reserved.
1 Introduction

1.1 Business Scenario
Historically, SAP customers have made large investments in on-premise Sales and Distribution application capabilities. The SAP SD module continues to be viable in the corporate system landscape, but many customers want to enable a fresh and intuitive user experience, increased functionality, and faster delivery of new functionality. The hybrid integration scenario is a great enabler of application delivery via the cloud, because it allows the customer to preserve the investment already made in the on-premise SAP SD module. By the utilization of solution content delivered for SAP Process Integration, a bridge between the on-premise SAP SD module and the SAP Hybris Cloud for Customer system is established, thus allowing the customer to take advantage of the strengths of both.

1.2 Background Information
This document details the steps required to enable bi-directional communication between an SAP Hybris Cloud for Customer and the on-premise SAP Sales and Distribution module, using SAP Process Integration as the on-premise middleware layer.

1.3 Prerequisites

SAP ERP
The ERP system must contain the following ABAP components:
1. SAP_BASIS 700 SP18 or higher
2. SAP_APPL 600 SP15 or higher

SAP Process Integration
SAP Process Integration 7.11 or higher is required. It is always recommended to install the latest support package.

SAP Hybris Cloud for Customer
Initial setup and configuration was performed in tenant, as per the SAP Hybris Cloud for Customer Administrator Guide.
2 Connect Phase: Check and Prepare SAP ERP System

2.1 ERP Software Components

Note: Remember to update the SPAM to the latest support pack prior to the installation of the Add-on.

Use transaction SAINT to install SAP Add-on CODERINT 600 and use transaction SPAM to implement the support packages in the ERP system.

1. Copy the installation package and support packages to the EPS/in directory within the “trans” directory.

2. Call transaction SAINT and load the packages from the menu Installation Package → Load Package → From Application Server.

3. Click Back

4. Click on Start to start the deployment of the Add-on.
5. Click *Continue*. It is possible to install the add-on together with all the support packages. Select the target support package, and click Continue.
6. Click Continue
7. Click No

8. Select the method of import and click the import button

2.2 Important SAP Notes for ERP-PI Integration

We recommend that you install the latest support package, and if necessary find all the relevant notes in the component LO-INT-COD. You can find a list of all ERP notes that may be relevant in this integration in the SAP Note 2293774.

2.3 Business Configuration Sets

1. Call transaction SCPR20 and enter the BC Set COD_BYD_ERP_INT.
2. Activate the BC Set clicking in the Activate BC Set button or press the F7 key.

3. Create a transport request that can be used for the activation in other systems.

4. Press Enter

2.4 RFC Destination to PI

1. Call transaction SM59 and create an RFC destination to point to the PI system of type 3.
2. Click in the Logon & Security tab and enter the user and password required to connect to PI system, which is the service account that was created in previous steps.

2.5 RFC Destination to PI (IDOC AAE Adapter)

Note: This destination is created if you have JAVA only based PI system.

1. Call transaction SM59 and create and RFC destination IDOC_AAE_<PI system> to point the PI system of type T.
2. In Technical settings, enter registered server program ID of the PI system

3. Enter Gateway details where the program ID is registered.

Note: The Program ID, Gateway host and Gateway service details can be found under Configuration→Infrastructure→Application Resources→inboundRA resource adapter in NWA of PI system.

2.6 Create SAP ERP User

From transaction SU01, create a service account with one of the following two roles and the type C or B:

SAP_SD_COD_INTEGRATION
SAP_SD_COD_INTEGRATION_EXT
How to Configure Integration between SAP ERP and SAP Hybris Cloud for Customer using SAP Process Integration
3 Connect Phase: Check and Prepare PI System

3.1 Access PI system

1. Go to SAP Logon. Enter details for your PI system and logon to it.

   ![SAP Logon](image)

   - New password
   - Client: 001
   - User: muster01
   - Password: ************
   - Logon Language: EN

2. Execute transaction SXMB_IFR.

3. Home page opens, from here PI clients can be accessed.

3.2 Create SLD Configuration

3.2.1 Create Business System in SLD for SAP ERP

   Note: The Technical system of type AS ABAP for SAP ERP system should be created.

1. Connect to the SLD to create the business systems for the SAP ERP technical system using the URL http://<hostname>:<port>/sld.
2. Click on link for Business Systems, and then in New Business Systems.

3. Select AS ABAP and the click Next.

4. Enter the System, client and URL and click Next.
5. Enter the name of the business system.

6. Click Next

7. Select Application System for Business System Role and the integration server of the Process Integration that will be used, and click finish.
3.2.2 Create Technical and Business System in SLD for SAP Hybris Cloud for Customer

1. Connect to the SLD to create the business systems for the SAP Hybris Cloud for Customer technical system using the URL http://<hostname>:<port>/sld.

2. Click in Technical systems and then the New Technical System.

3. Select the option Third-Party, and click Next.
4. Enter the technical System Identification and System Host Name, and click Next.

5. In the Installed Software phase, check the following Installed products and installed components and:
   - SAP BUSINESS BYDESIGN 1411
   - SAP BYD 2.40 part of SAP BUSINESS BYDESIGN FP4.0

7. Click in the Home button to return to the main page.

8. Click on Business Systems

7. Click New Business Systems

8. Select the Third-Party/Other system type, and click Next.
9. Select the corresponding technical system name, and add the logical system name of the SAP Hybris Cloud for Customers systems, and click Next.

![Select the technical system for the business system](image)

10. Enter the name of the business system, and click Next.

   **Business System Wizard**

   ![Enter the business system name](image)

11. In the Installed software step, select Products that are installed in the system and choose next.

   ![Business System Wizard](image)

12. Select the corresponding Integration system of the Process Integration system that will be used, and click Finish.
3.3 ERP PI Software Components

Using Enterprise Service Builder on Process Integration, install the Process Integration content.

1. Download the corresponding software components from the SAP Marketplace from the SAP Software Download Center.
   
   http://support.sap.com/swdc

2. Select the option Support Packages and Patches → Software Downloads

3. Choose Support Packages and Patches → By Category → SAP Content
4. Choose ESR Content (XI Content)

XI Content SAP BASIS 7.00
XI Content SAP BASIS 7.10
XI Content SAP BASIS 7.11
XI Content SAP_BYD 2.40
XI Content BYD COD 3.0
XI Content COD_ERP_INT 6.00
XI Content COD_ERP_INT_IC 6.00
XI Content SAP_APPL (600, 602, 603)
XI Content CRMCOD01 IC 700
XI Content SAP BASIS 7.30 (for JAVA based PI systems)

7. Unzip and copy the downloaded files to the <GLOBAL>\repository_server\import directory of the Process Integration system.
3.4 RFC Destination to SAP On-Premise

1. Call transaction SM59 and create and RFC destination to point to the ERP system of type 3.

2. Click in the Logon & Security tab and enter the user and password required to connect to ERP system, which is the service account that was created in previous steps.

3.5 PI Port Configuration

Call transaction IDX1 and create a new port using the RFC destination that was created in the previous step.
3.6 RFC Destination to SAP On-Premise (IDOC_AAE adapter)

**Note:** This destination is created if you have JAVA only based PI system.

1. Open PI NetWeaver Administrator page using the URL `https://<pi-host>:<https port>/nwa`
2. Navigate to Configuration ➔ Destinations.
3. Choose Create New destination.
4. In General data maintain the following details:
   - **Hosting System:** Local Java System <SID of PI system>
   - **Destination Name:** XI_IDOC_DEFAULT_DESTINATION_<SID of on-premise system>
   - **Destination Type:** RFC
5. Choose Next.
6. Under Connection and Transport security settings, maintain technical settings of the ERP on-premise system and choose Next.

![RFC Destination X_IDOC_DEFAULT_DESTINATION_Q2C](image)

**Connection and Transport Security Settings**

- **System ID:** QSE
- **Message Server:** id ... wdf.sap.corp
- **User Name and Password:** on-premise system technical user and password

7. Maintain Logon Data details as below and choose Next:
   - **Authentication:** Technical User
   - **Client:** <client of the on-premise system>
   - **User name and password:** on-premise system technical user and password
   - **Repository connection:** This destination using value help.

![RFC Destination X_IDOC_DEFAULT_DESTINATION_Q2C](image)

**Logon Data**

- **Authentication:** Technical User
- **Repository Connection:** This Destination


### 3.7 Resource Adapter (InboundRA) Configuration for IDOC_AAE Adapter

**Note:** This section is relevant if you have JAVA only based PI system.

1. Open PI NetWeaver Administrator page using the URL https://<pi-host>:<https port>/nwa
2. Navigate to Configuration ➔ Infrastructure ➔ Application resources

![Configuration](image)
3. **Search for inboundRA Resource Adapter.**

4. **Choose Properties tab and ensure following properties are defined in resource details section.**
   - **BindingKey**: PI_AAE_IDOC
   - **Local**: True. If set to False, maintain below Gatewayserver and GatewayService details.
   - **Gatewayserver**: <value maintained in destination>
   - **GatewayService**: <value maintained in destination>
   - **ProgramID**: <unique ID, value maintained in destination>
   - **MaxReaderThreadCount**: 5
   - **DestinationName**: XI_IDOC_DEFAULT_DESTINATION
   - **Multirepository**

### 3.8 Import TPZ Package in ESR

1. **Call the Process Integration URL to start the enterprise service builder, for example:**
   - [https://<host>:<port>/dir/start/index.jsp](https://<host>:<port>/dir/start/index.jsp)

2. **Open the enterprise service builder by clicking in the proper link.**
3. If JAVA JRE is installed, the Java Web Start Application for the ESR will open, you will have to select the usage profile, for example Unrestricted SAP Basis.

4. Once the Enterprise Service Builder is open, click in the menu Tools | Import Design Objects

5. Select the option of Server from the dialog screen.

6. Select each of the components that need to be imported and click OK.
7. Repeat the previous steps to import the other Process Integration Contents.

8. After all the content was imported you will see it available in the Design Object area.

3.9 Import Business System

1. On the PI browser page, Open Integration Builder.

2. Within the Integration builder, click in the menu Tools → Assign Business Systems.

3. Click continue
4. Click Continue

5. Select the business system for SAP ERP and SAP Hybris Cloud for Customers.
Note: If the Business system is not visible just Clear the SLD Cache by choosing Environment → Clear SLD Data Cache.

6. Click Finish

8. Click Close.

3.10 ALEAUD CHECK

1. In the PI system goto transaction SE38 and execute the report IDX_ALEREQUEST.
2. Ensure that no entry is selected for request of ALEAUD.
4 Set Up Secure Connection between ERP-PI-Cloud Systems

Note: Refer to the How to Configure x.509 Authentication for SAP PI Systems to Connect to/from SAP Hybris Cloud for Customers Guide to set up Basic Authentication and Certificate based authentication.

4.1 Supported Certification Authorities (PI Integration)

1. Download the root certificates from the following URL

   https://secure.omniroot.com/support/sureserver/rootcert.cfm

   Note: In case of error downloading certificates, go to Internet explorer (Tools->Internet options->content->Certificates -> Trusted Root Certification authorities). Export the relevant certificate from the list.
2. Open NWA in the PI system

![NWA](image)

3. Under the tab Configuration, click Certificates and Keys.

![Certificates](image)

4. Look for the view called TrustedCAs, and select it.
5. Import the two root certificates that were downloaded using the Import Entry button under TrustedCAs.

6. Select the entry type X.509 Certificate and the location of the certificate file and click Import.

7. Repeat the process for the second certificate.

4.2 Check End-to-End Connectivity

1. Go to transaction SE38 in the SAP ERP system.
2. In Program field enter report name RCOD_CHECK_E2E_CONNECTIVITY
3. Choose Execute.
5 Configure Phase: Configure Integration in Cloud Solution

5.1 Activate SAP ERP Integration in Scoping

In this section, you activate SAP Hybris Cloud for Customer with SAP ERP, and specify the scope of the integration between the systems.

1. Connect to the SAP Hybris Cloud for Customers system using an Internet browser, and open the Business Configuration tab.

2. Click in All Current Projects.

3. Select the project and click Edit Project Scope

4. Click Next
5. Click Next, and under Communication and Information Exchange → Integration with External Application and Solutions, select Integration with SAP ERP, Integration of Master Data and Integration into Sales, Service and Marketing Processes.

6. Click Next, and under Communication and Information Exchange → Integration with External Application and Solutions → Integration with SAP ERP, select the following scenarios:
   - Do you want to replicate accounts and contacts from your cloud solution to your SAP ERP solution?
   - Do you want to replicate accounts and contacts from your SAP ERP application to your cloud solution?
   - Do you use your SAP ERP system to calculate prices for opportunity items in your cloud solution?
7. Under Communication and information Exchange   Integration with External Application and Solutions   Integration of Master Data, select the following scenario:
Do you want to replicate product data from an external application or solution to your cloud solution?

8. Under Communication and information Exchange   Integration with External Application and Solutions   Integration into Sales, Services and Marketing Processes, select the following scenario:

9. Click Next, and then Finish.

5.2 Setup Communication System

1. Under the tab Administrator, click in Communication Systems.
How to Configure Integration between SAP ERP and SAP Hybris Cloud for Customer using SAP Process Integration

2. Click New to create a new communication system.

3. Enter the information about the backend ERP system. It is important to note that all the information requested on the screen below is associated with the ERP system (logical system name, SAP client, and so on). In addition, make sure to check the option of “SAP Business Suite”.

Note: For attachment replication to work from SAP ERP to SAP Hybris Cloud for Customer, ensure the Business System ID maintained in the SAP Hybris Cloud for Customer communication system should match with the Business system created in SAP PI SLD pointing to SAP ERP system.
4. Click on Actions → Set to Active

![NEW COMMUNICATION SYSTEM](image)

5. Click on Save and Close.

![NEW COMMUNICATION SYSTEM](image)

5.3 Configure Communication Arrangements

Note: You can find a list of all the communication arrangements and the corresponding service interfaces in the Integration Flow spreadsheet on SAP Service Marketplace.

Refer to the How to Configure x.509 Authentication for SAP PI Systems to Connect to/from SAP Hybris Cloud for Customers Guide to set up Basic Authentication and Certificate based Authentication.

5.3.1 Mass Configuration of Communication Arrangements

1. In the SAP Hybris Cloud for Customer system select the ADMINISTRATOR workcentre, and then select the task Communication Arrangement for On Premise Systems.

![Customised workcentre](image)
2. In the Select Communication System step enter the following details:
   - SAP backend integration system and integration middleware.
   - Communication system and code list mapping.

3. Choose Next.

4. Under Communication Arrangements tab, select the communication scenarios relevant for your scope and Next. Choose Select All in case you want to configure all of the communication scenarios.
   Note: In case you do not see any of the configuration scenarios, re-check the project scoping to add the necessary scoping elements.

5. To configure inbound communication credentials choose Edit Credentials.
6. In the Certificate tab click on Upload Certificate and choose the Process Integration client certificate.
7. Choose OK.
8. For outbound communication credentials, select Download.

9. Download the SAP Hybris Cloud for Customer Client Certificate x.509(example C4CClient.cer) and choose Save. This file has to be uploaded later to PI system.


11. Under Confirmation, Choose Close.
5.3.2 Configure Communication Arrangements for Outbound Communication

Disclaimer:

The url’s and the port numbers mentioned in this document are for illustration purpose only. The url and port number varies on your system setup and landscape.

1. Connect to the SAP Hybris Cloud for Customer system using an Internet browser, and open the Administrator tab.

2. Click in the communication arrangements link.

Integration

Set up and maintain communication with external systems

Communication Systems

Communication Arrangements

3. Edit the communication Arrangements with outbound interfaces, adding the correct URL for the Process Integration web server.

This URL can be obtained from PI sender agreement object of a business object in Integration Builder. To obtain this, double click on the sender agreement. Select sender agreement -> Display WSDL. If you scroll to the end of the window, you will find the URL.
The following table shows an example of the URL that have to be used where we use the Business System or Business Component, Business scenario names are also mentioned. For example

| Customer Replication          | /XISOAPAdapter/MessageServlet?channel=<:business_system>:COD_SOAP_BusinessPartnerReplication_Send |
| Customer Address Replication  | /XISOAPAdapter/MessageServlet?channel=<:business_system>:COD_SOAP_BusinessPartnerAddress_Send |
| Customer Contact Replication  | /XISOAPAdapter/MessageServlet?channel=<:business_system>:COD_SOAP_BusinessPartnerContact_Send |
| Opp with Follow Up            | /XISOAPAdapter/MessageServlet?channel=<:business_system>:COD_SOAP_OpportunityWithFollowup_Send |
| Sales Doc Print Preview       | /XISOAPAdapter/MessageServlet?channel=<:business_system>:COD_SOAP_SalesDocPrintPreview |
| Product Pricing               | /XISOAPAdapter/MessageServlet?channel=<:business_system>:COD_SOAP_SalesOrderPricing_Send |
| Query Sales Quote             | /XISOAPAdapter/MessageServlet?channel=<:business_system>:COD_SOAP_QueryCustomerQuote_Send |
| Query Sales Order             | /XISOAPAdapter/MessageServlet?channel=<:business_system>:COD_SOAP_QuerySalesOrder_Send |

For example, here is URL:

/XISOAPAdapter/MessageServlet?channel=VQR_005:COD_SOAP_BusinessPartnerReplication_Send

4. Select one of the communication arrangements, and click Edit.
5. Click in the Technical Data Tab.

6. Click in Edit Advance Settings button.

7. Click in the Outbound Tab.

8. Select each of the outbound services and edit SSL port and Path.
9. Click on Save and Reactivate.

Note. After setting up the SAP Process Integration system, you can check if there is connectivity from the cloud system to the Process Integration system by selecting one of the outbound services and click Check Connection. This will only check connectivity with the SOAP Adapter in Process Integration, and not the actual communication channel. If there is any problem with SSL certificates or authentication, it will show an error here.
10. Click Close and then Yes to activate the changes.

### 5.4 Export the Root Certificate

1. Navigate to the folder where you have downloaded x.509 certificate (example C4CClient.cer) of SAP Hybris Cloud for Customer Outbound Communication arrangement as explained in previous section.
2. Open the certificate by double clicking on it.
3. In Certification Path tab, select the root certificate and choose View Certificate.

4. In Details tab, click Copy to File..

6. Select the option Base-64 encoded X.509(.CER) and choose Next.

7. Click on Browse to save the certificate in your local folder. Provide a name for the certificate and choose Save.

8. Choose Next.

5.5 Determine Short Tenant ID

1. Log in to the SAP Hybris Cloud for Customer system.
2. Choose Communication Arrangements under Administrator → Integration.

3. Select a communication arrangement created above. Example Business Partner Replication from SAP ERP.

4. Note the short tenant ID under My Communication Data → My System.

5.6 Optional: Maintain ERP Number Ranges

2. Select the row that contains your project and choose Open Activity List.


4. Click the link Integration of Business Partner Data from your Cloud Solution to SAP ERP.

5. Ensure the number ranges defined here match with the number ranges defined in the ERP system. Choose Save and Close.
5.7 Perform Code List Mapping

5.7.1 Manually map the Code Lists

1. Connect to the SAP Hybris Cloud for Customers system using an Internet browser, and Goto Business Configuration Work Center ➔ Implementation Projects.

2. Click in All Current Projects.

3. Select the project, and click on Open Activity List.

5. Choose Maintain Code List Mapping

6. In the Code List Mapping Definition Section choose the Local Data Type Name.

CODE LIST MAPPING

You can maintain mappings for configuration values used in data exchange between your on-demand solution and the external system.

Code List Mapping Definition

   - Local and Remote Codes Are Equal : Values are same in the Backend SAP ERP and SAP Hybris Cloud for Customer system
   - Map Individual Codes: Values are mapped explicitly in the Code List Mapping Section
8. For each Map Individual Codes rule, review and if necessary, adapt the existing values. Click Missing Code Mappings to display local codes that have not yet been mapped to an external code. Maintain the values as maintained in the Backend ERP system.

5.7.2 Automated Configuration of Code List Mapping

1. Log in to the SAP Hybris Cloud for Customer system.

2. In the Business Configuration Work Center, Choose DOWNLOAD CODE LIST
3. Click on link Download Code List.

4. Enter the Code List Mapping Group, Language, Delimiter and Select Download.

5. Enter the name of file you want to download in .zip format. For example codeList.zip.
6. The Code List will be downloaded in the path you have mentioned.
7. Log onto the ERP Backend that the SAP Hybris Cloud for Customer is connected to.
8. Enter the transaction SE38 and run the report CODD_CODE_LIST_MAPPING.

9. Choose execute.
10. Alternately you can Execute the program CODD_CODE_LIST_MAPPING using the below options.

<table>
<thead>
<tr>
<th>Transaction code</th>
<th>CODD_CODE_LIST_MAP</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP ERP IMG menu</td>
<td>Integration With Other mySAP.com Components → Integration With SAP Cloud for Customer → Download ERP Customizing Information for Code Lists</td>
</tr>
</tbody>
</table>

11. Enter the main language and following details:
   - **Merged Customizing directory** is where you want the merged code list mappings filled.
   - **Cloud for Customer Business configuration File** is the codeList.zip file that was downloaded from the SAP Hybris Cloud for Customer system.
12. Choose execute.
13. After this the CodeOutput.zip file is saved in the directory mentioned, this zip contains all the code lists for the mentioned languages.
14. Log in to the SAP Hybris Cloud for Customer system again.
15. In the Business Configuration: work center choose Upload Code List.
16. Choose Upload Code List:

17. Enter the Code List Mapping Group and select upload.

18. Choose the file that was generated from SAP ERP Backend system. The name of the file is mentioned in the Merged Customizing Directory field of the report.
19. Now the code list mapping in SAP Hybris Cloud for Customer is updated.

5.8 Create ID Mapping
- Create ID Mapping for Sales Org

1. Under the context menu for the tab ADMINISTRATOR, select the option ID MAPPING FOR INTEGRATION.

2. Click on Edit ID Mapping for Integration.

3. In the “Mapping Of” field, select ERP Sales Organization and in the System Instance ID, select the communication system created in previous steps, and click Go.
4. Enter the external ID of the sales organization that will be mapped from ERP with the sales organization on SAP Hybris Cloud for Customers.

5. Click Save

- Create ID Mapping for Product Category

1. Under the context menu for the tab ADMINISTRATOR, select the option ID MAPPING FOR INTEGRATION.

2. Click on edit ID Mapping for integration.
3. In the “Mapping Of” field, select ERP Product Categories and in the System Instance ID field, select the communication system created in previous steps, and click Go.

4. Enter the external ID of the product category to be mapped from ERP with the product category on SAP Hybris Cloud for Customers.

5. Click Save.

5.8.1 ID Mapping Using the Microsoft Excel Template

1. In the “Mapping Of” field, select CRM Organizations and Units and in the System Instance ID, select the communication system created in previous steps, and click Go. Next choose ID Mapping to Microsoft Excel.
How to Configure Integration between SAP ERP and SAP Hybris Cloud for Customer using SAP Process Integration

2. Data is downloaded to an excel file. Open the Excel file and enable Macros if prompted for.

3. Navigate to SAP Add-In and choose Logon.

4. Enter the SAP Hybris Cloud for Customer URL and logon details and click Log On.

5. Make the relevant changes to the Excel file in External ID field and choose Save.

ID MAPPING FOR INTEGRATION

Save Close

7. An Excel template is downloaded. Open the file and accept macros.

8. Navigate to SAP Hybris Cloud for Customer and choose Logon.

9. Enter the SAP Hybris Cloud for Customer URL and logon details and choose Log On.

10. Copy the content from the excel file where you saved the changes and then choose SAP Add-In → Workbook → Save Date to, to save the data to Cloud.
5.9 Optional: Handling of Inconsistent Address Data

1. Connect to the SAP Hybris Cloud for Customers system using the internet browser and open the Business Configuration tab.

2. Click All Current Projects

3. Choose Open Activity List.


5. Show All Activities and find for Address Checks.
6. Select Address Checks and Click button Add to Project.

7. Open Address Checks.

8. Select the checkbox Allow Saving of inconsistent address based on your business requirements.

9. Save and close the activity.
6 Configure Phase: Configure Integration in SAP ERP

6.1 Add an Authorization Profile for a Role

1. Call transaction PFCG
2. Enter the role SAP_SD_COD_INTEGRATION_EXT.

3. Open the role for changes, and select the tab Authorizations → Change Authorization Data.

4. Look for the security object S_SERVICE under Cross-application Authorization Objects, and change the field SRV_NAME.
5. Add the following services:
   ECC_SALESORDER009QR
   ECC_CUSTOMERQUOTE006QR

6. Save and generate the profile.

6.2 SAP Customizing Implementation Guide in the ERP system

All the customization activities necessary to integrate SAP ERP with SAP Hybris Cloud for Customer are defined in a hierarchical structure in the SAP Implementation Guide structure. The necessary documentation is also made available with the activity.
6.3 **Automatically Generate Integration Settings for Data Exchange**

1. To **Automatically Generate Connectivity settings for Data Exchange**, navigate using one of the following paths.

<table>
<thead>
<tr>
<th><strong>Transaction code</strong></th>
<th><strong>RCODCONNECTIVITY</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAP ERP IMG menu</strong></td>
<td><em>Integration With Other mySAP.com Components → Integration With SAP Cloud for Customer → Communication Setup → Automatically Generate Integration Settings for Data Exchange</em></td>
</tr>
</tbody>
</table>
2. In the first screen select the middleware scenario you would like to test and press next.

3. In the second screen select the scenarios you would like to generate the configuration entities for and press next.
4. In the third screen choose the logical system you would like to use in your test case. If you have executed the preparation step then you might take the one which you have recently created and press next.

5. On the fourth screen you have to maintain the information which will be taken over to the destination objects. Depending on your choice of the first screen this screen will be rendered dynamically. Select button “Next”. The below screenshot is shown if Dual Stack Java is selected in first screen.
If JAVA based PI is selected in the first screen, then the following screen will be shown in this step.

Enter the Unique Program ID, Gateway Host and Gateway Service details maintained in InboundRA resource adapter in below path of PI NWA. Configuration → Infrastructure → Application Resources.
6. On the fifth and last screen you can see a summary about your selected information. Select button “Generate” and accept the confirmation dialog box.

<table>
<thead>
<tr>
<th>Connectivity Set Up: Step 5 of 5 - Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Summary" /></td>
</tr>
</tbody>
</table>

7. In the log you can check which entities were created.
6.4 Area Menu

An area menu is now available to consolidate all the commonly used transactions for integrating SAP ERP with the SAP Hybris Cloud for Customer solution. You can access this area menu in the transaction COD_INT_MENU.
How to Configure Integration between SAP ERP and SAP Hybris Cloud for Customer using SAP Process Integration
7 Configure Phase: Configure ERP Integration in PI System

7.1 Create a Key Storage View and load the certificate

1. Logon to NetWeaver Administrator (NWA) of the SAP PI system.

2. In the Configuration tab, click Certificate and Keys.

3. In the Key Storage tab, click Add View.

4. Enter a name and description, and click Create.

5. Select the view you just created, and click Import Entry.
6. In the Entry Import dialog, do the following:
   a. Select the entry type as PKCS#12 Key Pair.
   
   ![Entry Import dialog screenshot](image)

   b. Select the file that you created as the key pair in SAP Hybris Cloud for Customer.
   c. Enter the corresponding password.
   d. Click Import.

7.2 Import the Root Certificate

1. Load certificate into SSL Server standard for ABAP
2. Using SAPGUI, logon to the ABAP stack of the SAP PI system, and open transaction STRUST.
3. Open SSL server standard, and click the import button under Certificate.

4. Select the location of the root certificate and click Continue.
5. Under Certificate, click Add to certificate List and click Save.

7.3 Create ERP Configuration Scenarios
Based on the PI stack (dual or single), use one of the 2 sections mentioned below.

7.3.1 ABAP Based PI Stack

1. The following scenarios will be created based on ES repository models. They will be created one at the time. Each scenario has multiple connections that require communication channels to be created as follows:

<table>
<thead>
<tr>
<th>For COD_ERP_MasterDataSync</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Account Replication</strong></td>
</tr>
<tr>
<td>Asynchronous</td>
</tr>
<tr>
<td>COD</td>
</tr>
<tr>
<td>ERP</td>
</tr>
<tr>
<td>COD_Hybris_BusinessPartnerReplication_Send</td>
</tr>
<tr>
<td><strong>Account Address Replication</strong></td>
</tr>
<tr>
<td>Asynchronous</td>
</tr>
<tr>
<td>COD</td>
</tr>
<tr>
<td>ERP</td>
</tr>
<tr>
<td>COD_Hybris_BusinessPartnerAddress_Send</td>
</tr>
<tr>
<td><strong>Account Contact Replication</strong></td>
</tr>
<tr>
<td>Asynchronous</td>
</tr>
<tr>
<td>COD</td>
</tr>
<tr>
<td>ERP</td>
</tr>
<tr>
<td>COD_Hybris_BusinessPartnerContact_Send</td>
</tr>
<tr>
<td><strong>Account Replication</strong></td>
</tr>
<tr>
<td>Asynchronous</td>
</tr>
<tr>
<td>ERP</td>
</tr>
<tr>
<td>N/A</td>
</tr>
<tr>
<td>COD_Hybris_BusinessPartnerReplication_Receive</td>
</tr>
<tr>
<td><strong>Account Address Replication</strong></td>
</tr>
<tr>
<td>Asynchronous</td>
</tr>
<tr>
<td>ERP</td>
</tr>
<tr>
<td>N/A</td>
</tr>
<tr>
<td>COD_Hybris_BusinessPartnerAddress_Receive</td>
</tr>
<tr>
<td><strong>Account Contact Replication</strong></td>
</tr>
<tr>
<td>Asynchronous</td>
</tr>
<tr>
<td>ERP</td>
</tr>
<tr>
<td>N/A</td>
</tr>
<tr>
<td>COD_Hybris_BusinessPartnerContact_Receive</td>
</tr>
<tr>
<td><strong>Product Data Replication</strong></td>
</tr>
<tr>
<td>Asynchronous</td>
</tr>
<tr>
<td>ERP</td>
</tr>
<tr>
<td>N/A</td>
</tr>
<tr>
<td>COD_Hybris_ProductDataReplication_Receive</td>
</tr>
</tbody>
</table>
2. From within the integration builder click on the menu Tools → Apply Model from ES Repository.

3. Click in the input help button to load the available modes from the ESR repository.

2. Look for the COD_ERP_MasterDataSync, Select it and click Apply.
5. Click Continue

6. Define the name of the scenario, and click Finish.

7. Click Close

7.3.2 JAVA Based PI Stack

1. The following scenarios will be created based on ES repository models. They will be created one at the time. Each scenario has multiple connections that require communication channels to be created as follows:
   - COD_ERP_MasterDataSync_AAE
   - COD_ERP_BusinessDataSync_AAE
2. From within the integration builder click on the menu Tools → Apply Model from ES Repository.

3. Click in the input help button to load the available modes from the ESR repository.

1. Look for the COD_ERP_MasterDataSync_AAE, Select it and click Apply.

5. Click Continue
How to Configure Integration between SAP ERP and SAP Hybris Cloud for Customer using SAP Process Integration

6. Define the name of the scenario, and click Finish.

7. Click Close

7.4 Configure Interfaces

Note: This section describes steps for the dual stack. The main difference in case of JAVA only installation of PI system is the scenario names are different as listed below:
COD_ERP_MasterDataSync_AAE
COD_ERP_BusinessDataSync_AAE

7.4.1 Assign the Business Systems to Each Components

1. Assign the business systems to the scenario. Select the COD Template Cloud for customers in the Model Configurator.
2. Assign the business system using the input help button from the Business System Component for A2A tab.

1. From the Choose Communication Component screen, select “Business System” in the communication component section. Then select the business system created for the SAP Hybris Cloud for Customer, and click Apply.

4. Assign the business system for the SAP ERP system. First, select the SAP ERP 6.0 upwards Template in the model configurator.
5. Assign the business system using the input help button from the Business System Component for A2A tab.

6. From the Choose Communication Component screen select “Business System” in the communication component section, then select the business system created for the SAP ERP System, and click Apply.

7.4.2 Create the Communication Channels and Assign them to Sender and Receiver Business System Components

1. Configure the connections by clicking in the Configure Connection button in the Model Configurator screen.
2. In the Connections from Component Assignment tab, create the communication channels from the templates for each of the connection within the scenario. Select the communication channel field for the SAP Hybris Cloud for Customers, or in this case the Sender Business System Component,

3. Click the Create Communication Channel button and create using the template option.

4. In the Create Communication Channel wizard, click Continue,

5. Click Continue
6. Adjust the name of the communication channel or just accept the standard name, and click Finish.

7. Click Close

8. The communication channel for this integration scenario is created and assigned.

9. Click in the Communication Channel field of the Receiver Business System.
10. Click in the Create Communication Channel button.

11. In the Create Communication Channel wizard, click Continue.

12. Click Continue

13. Verify the name of the communication channel, and click Finish.
14. Click Close

Note. The communication channel ERP_Idoc_Receive can be reused for all the connection from SAP Hybris Cloud for Customer to SAP ERP and does not have to be recreated. Select the input help button in the receiver communication channel.

Select the existing communication channel, and click Apply.
15. This connection is configured with the communication channels created. Now click in the Next Connection arrow to configure the Next Connection.

16. Repeat the previous steps for the other connections within the scenario.

### 7.4.3 Generate Process Integration Configuration Objects

1. When all the communication channels are created and assigned to the connection within the scenario, create the configuration objects by clicking in the configuration objects button.

2. In the Create Configuration Objects screen, select the option Generation. In the Change List, create a new list and click Start.
3. All the objects will be generated and a generation log will be created.

After reviewing, close the generation log screen.
4. Click in Apply.

5. Save the scenario.

6. Repeat the previous steps for each of the scenarios, connections and communication channels.

7.4.4 Configure ERP_IDOC_receive Communication Channel with correct Port and RFC Destination

1. From the COD_ERP_BusinessDataSync scenario → Communication Channel open the communication channel ERP_Idoc_Receive.
2. Click in the change Edit button.

3. Adjust the RFC destination and port.

4. Save changes by clicking the Save button.
7.5 **Maintain Communication Channel for ERP Integration**

1. On each of the scenarios, open all the communication channels where the receiver is the SAP Hybris Cloud for Customer.

   ![Communication Channel](image)

   **Example:**
   - Case 1: If the communication channel points to Cloud solution as a receiver, then SAP Hybris Cloud for Customer Inbound Communication Arrangements’ URL must match with this target URL.

2. Click the pencil icon to open the communication channel for edit.

   ![Display Communication Channel](image)

3. Finally adjust all the connection parameters settings, according to the requirements.

   ![Connection Parameters](image)

   Based on the communication channel, the target URL must match with the corresponding system’s URL.

   **Example:**
   - Case 1: If the communication channel points to Cloud solution as a receiver, then SAP Hybris Cloud for Customer Inbound Communication Arrangements’ URL must match with this target URL.
Note: In case of JAVA only based PI stack, check the fields *Use Encoded headers* and *Use Query String* for the message to reach successful to the SAP Hybris Cloud for Customer system.

Case 2: If the communication channel points to ERP as a receiver, then ERP SOAMANAGER URL must match with this target URL.
5. Click the Save button.

7.6 Adjust Routing Conditions for ERP Integration

1. On the PI browser page, open Integration Builder.
2. Switch to configuration scenario view

3. Goto configuration scenario <prefix>_COD_ERP_BusinessDataSync → Interface determination for the sender IDOC interface ORDERS.ORDER05.

4. Switch to edit mode.

5. Maintain the routing condition using the condition editor as follows.

Note: For details on routing conditions and the operation mapping, see the Integration Flows spreadsheet.
7.7 Maintain Value Mapping between Cloud and ERP in PI

1. On the PI browser page, open the Integration Builder.


4. Switch to Edit Mode to maintain the Value Mapping. The values in COD_PartyRoleCode represent concatenations of the SAP CRM Business Object Types and party role codes. The values in the CRM_PartyRoleCode is concatenation of the SAP CRM Business object types and partner functions as described in the Integration Guide.

<table>
<thead>
<tr>
<th>Value</th>
<th>Value</th>
<th>Group Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUS2000111193</td>
<td>BUS20001110000021</td>
<td>RoleCode</td>
</tr>
<tr>
<td>BUS2000111496</td>
<td>BUS20001110000012</td>
<td>RoleCode</td>
</tr>
<tr>
<td>BUS2000111925</td>
<td>BUS20001110000024</td>
<td>RoleCode</td>
</tr>
<tr>
<td>BUS2000101939</td>
<td>BUS20001010000022</td>
<td>RoleCode</td>
</tr>
<tr>
<td>BUS2000111931</td>
<td>BUS20001110000021</td>
<td>RoleCode</td>
</tr>
<tr>
<td>BUS2000111932</td>
<td>BUS20001110000022</td>
<td>RoleCode</td>
</tr>
</tbody>
</table>

5. Save the Value Mapping.

6. Repeat the steps for all the agencies and schemes described in the Integration guide.

7.8 **Activate Changes in Change List**

1. Click the Change Lists tab on the Integration Builder.

2. Expand the change list and activate all the communication channels. They should be in the Standard Change List. Using the context menu, click Activate.
3. Some of the communication channels are within the other specific change list, Activate those communication channels first, and then the rest of the objects.

4. Click in Activate
5. Click Close

6. Activate the rest of the activation list for each of the scenarios following the steps above.
How to Configure Integration between SAP ERP and SAP Hybris Cloud for Customer using SAP Process Integration

<table>
<thead>
<tr>
<th></th>
<th>CR8001_HR240_CRM_COD_Business</th>
<th>Open</th>
<th>01-22-10</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>QSE_004</td>
<td>CRMPCD_CAMPAIGN</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>QSE_004</td>
<td>CRMIF_ORDER_SAVE_M</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>QSE_004</td>
<td>CRMIF_ORDER_SAVE_M</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>QSE_004</td>
<td>CRMIF_PARTNER_SAVE_M</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>VQW_005</td>
<td>COD_SOAP_Account-HierarchyReplicationIn_Receive</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>VQW_005</td>
<td>COD_SOAP_BusinessPartnerConfirmationIn_Receive</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>VQW_005</td>
<td>COD_SOAP_BusinessPartnerRelationshipReplicationIn_Receive</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>VQW_005</td>
<td>COD_SOAP_BusinessPartnerReplicationIn_Receive</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>VQW_005</td>
<td>COD_SOAP_EmployeeReplicationIn_Receive</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>VQW_005</td>
<td>COD_SOAP_MaterialReplicationIn_Receive</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>VQW_005</td>
<td>COD_SOAP_OrganisationUnitReplicationIn_Receive</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>VQW_005</td>
<td>COD_SOAP_ProductCategoryHierarchyReplicationIn_Receive</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>VQW_005</td>
<td>COD_SOAP_TerritoryReplicationIn_Receive</td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td>QSE_004</td>
<td>VQW_005</td>
<td>AppointmentActivityConfirmationIn</td>
</tr>
<tr>
<td></td>
<td>QSE_004</td>
<td>VQW_005</td>
<td>AppointmentActivityReplicationIn</td>
</tr>
<tr>
<td></td>
<td>QSE_004</td>
<td>VQW_005</td>
<td>CampaignReplicationInitiatedByExternalIn</td>
</tr>
<tr>
<td></td>
<td>QSE_004</td>
<td>VQW_005</td>
<td>EmailActivityConfirmationIn</td>
</tr>
<tr>
<td></td>
<td>QSE_004</td>
<td>VQW_005</td>
<td>EmailActivityReplicationIn</td>
</tr>
</tbody>
</table>
8 Data Load Phase: Perform Initial Data Load

1. In SAP ERP system, execute transaction BD10 for Material Master.
2. Enter the Material you want to send to SAP Hybris Cloud for Customer system, Message type as MATMAS_CFS and Logical system created for SAP Hybris Cloud for Customer.

3. Choose Execute.

4. To replicate Customer Master, execute transaction BD12.
5. Enter the Customer you want to send to SAP Hybris Cloud for Customer, Output Type as DEBMAS_CFS and Logical System of SAP Hybris Cloud for Customer.

6. Choose Execute.

7. To replicate Sales org, execute transaction SE38.
8. In program field enter the report name COD_ERP_ORG_UNIT_EXTRACT and choose Execute.
9. Under Organizational Data, enter the criteria of the sales org unit which needs to be replicated, language as EN, Partner Number of Receiver of the SAP Hybris Cloud for Customer and choose Execute.

10. To replicate Customer hierarchy, execute transaction SE38.

11. In program field enter the report name RCOD_CUSTHIER_EXTRACT and choose Execute.

12. Enter the details in the report like Customer Hierarchy type, Sales org, Distribution Channel, Division, Customer, Reference Date and Logical system of SAP Hybris Cloud for Customer and choose Execute.

Note: Use transaction WE05 to check if the IDoc were processed successfully.
9 Monitor Phase: Monitor Message Flow Across Systems

Refer to the ‘Monitoring Guide’ to monitor data flow from SAP ERP to SAP Hybris Cloud for Customer System and vice versa.
10 Appendix

10.1 Register Service for IDoc Inbound

1. Open the Transaction SRTIDOC.
2. Select the Register service checkbox and maintain the following values.

   **Register Service for SOAP Runtime (No Operation/Configuration)**

   - **Register Service**
   - **Cancel Registration**
   - **Service Attributes**
     - **URL SOAP Application**: /umsap-com-soap:runtime:application:idoc
     - **Name of Web Service Definition**: GENERIC
     - **Call Address (ICF Path)**: /sap/bc/srt/idoc
     - **Number of Virtual Host**: 

3. Choose execute.

   **Register Service for SOAP Runtime (No Operation/Configuration)**

   - **Register Service**
   - **Cancel Registration**
   - **Service Attributes**
     - **URL SOAP Application**: /umsap-com-soap:runtime:application:idoc
     - **Name of Web Service Definition**: GENERIC
     - **Call Address (ICF Path)**: /sap/bc/srt/idoc
     - **Number of Virtual Host**: 

10.2 Maintain Requirement Routine

1. Call transaction VOFM and click on menu Requirements → Output Control.

2. At the bottom of the table enter an unused number greater than 600 and assign application V1.
3. Click Save

4. Click on New Entry and click on Source Text.

5. Insert the following code, save, and activate.

```
FORM kobed_xxx.
  * We only trigger the confirmation back to 'Cloud for Customer'
  * if the document is complete and if an opportunity document is
  * referenced.
  IF komkbv1-uvall EQ 'C' AND
     cl_cod_oppt_confirmation=>is_relevant( komkbv1 ) = abap_true.
     sy-subrc = 0.
  ELSE.
     sy-subrc = 4. ENDIF.
ENDFORM.
```
10.3 Maintain Output Determination procedure

1. In the SAP IMG Follow the Navigation path
   Sales and Distribution  ➔  Basic Functions  ➔  Output Determination  ➔  Output Determination Using the Condition Technique  ➔  Maintain Output Determination for Sales Documents  ➔  Maintain Output Determination Procedure.
   Alternatively call transaction SM34 to maintain view VVC_T683_XX_V1.

2. Mark the output determination procedure assigned to the order type Inquiry Output. In the Customizing delivered as standard, this is procedure V05000.

3. Choose Control Data within the Dialog Structure view.
4. Choose *New Entries* and assign the output type COD1 with the requirement number defined in the "Maintain Requirement Routine".

5. Save the entry and return to the procedures

6. Repeat the process for other output determination procedures mentioned in the Integration guide.

### 10.4 Maintain Output Record

1. Call transaction VV11 and use the output type COD1.

2. From menu output conditions, select Create with template.
3. Create the following entries:

10.5 **Activate Event Linkage**

1. Call transaction SWETYPV.

2. Open object type BUS2030 and the event CREATED, Choose Details, and check the Linkage Activated checkbox.
10.6 Maintain Endpoints for Services

Purpose

The access URL of the endpoint that is obtained while configuring the SAP Hybris Cloud for Customer system to establish the synchronous requests.

Procedure

1. Navigate using one of the following method.

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SAP ERP IMG menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOAMANAGER</td>
<td>Integration With Other SAP Components → Integration With SAP Cloud for Customer → Communication Setup → Manually Adjust Integration Settings for Data Exchange → Configuration in SOA Management</td>
</tr>
</tbody>
</table>

2. Click on Simplified Web Service Configuration under Service Administration.
3. Search for the object name: SalesOrderPricingInformationQueryResponse_In.

4. Select the Web service name and click on Set Selected. Check the fields User Name/Password (Basic) and X.509 Client Certificate.

5. Choose Save.

6. Perform the previous steps for the following services:
   - SalesDocumentPrintPreviewQuery
   - SalesOrderERPBasicDataByElementsQueryResponse_In
   - CustomerQuoteERPBasicDataByElementsQueryResponse_In
   - COD_SALESORDER_SIMULATE

10.7 Activate Change Pointers for IDOCs

This is a prerequisite for Initial Data Load.

2. Call transaction SALE, IDOC Interface / Application Link Enabling (ALE) → Modeling and Implementing Business Processes → Master Data Replication → Replication of Modified Data
3. Click on Activate Change Pointers – Generally and enable the setting.

4. Click back and open the option Activate Change Pointer for Message Types, and select the active checkbox for the message types:
   - MATMAS_CFS
   - DEBMAS_CFS
   - ADRMAS
   - ADR3MAS
   - COD_CUSTHIERMAS

   For example:
10.8 **Work Ticket Integration**

Refer to the ‘Quick Start Guide’ to integrate Work tickets in Cloud into controlling in SAP ERP.

10.9 **Configuration to replicate international customer names and addresses**

2. Call transaction SPRO in your on-premise SAP ERP system.

4. Choose Continue.
5. Activate the address versions that you want to have in the system by checking the Active checkbox. Choose Save.

6. In your SAP Hybris Cloud for Customer system, open the Business Configuration tab.

7. Click All Current Projects.
8. Select the Project and choose Edit Project Scope.

9. Click Next twice.
10. In Scoping, make sure that Built-in Services and Support → Business Environment → Addresses and Languages are selected.
11. Click Next.
12. In the Questions tab, choose the Option Do you want to specify textual master data using international address versions?
13. In the same screen, choose the relevant languages that you want to have in your system.
14. Finish the Scoping and Open the Activity List.
15. Choose Fine-Tune activity.
16. Choose All Activities from the Show dropdown and search for Additional Communication Languages.
17. Select the activity Additional Communication Languages and Choose Add to Project

18. Choose the activity Additional Communication Languages.
19. Choose Language is Allowed for the languages that you want to have in your system. Choose Save and Close.
   Note: - Once an international address is maintained in Cloud, the system does not allow you to disable this feature.

10.10 Configuration to send attachments from SAP ERP to SAP Hybris Cloud for Customer

1. Call transaction SOAMANAGER and login with your credentials if asked for.

2. Choose Web Service Configuration under the tab Service Administration.
3. Select Object Type as Consumer Proxy and enter object name as: CO_CODERINT_ATTACHMENT_FOLDER and choose Search. Select the hyperlink in the result list.

4. Under Configurations, choose Create Service.
5. Enter Logical port Name, Description, and select the check box Logical port is default. Choose Next.

6. Under Consumer Security, under Authentication Settings check User ID/Password. Enter the User ID and password of the RFC destination maintained in SAP ERP pointing to the SAP PI system. Choose Next.

7. Under HTTPS settings maintain the following values
   URL Access Path: Endpoint maintained in PI
   Computer Name of Access URL: PI system
   Port Number of Access URL: Choose Next.
8. On the SOAP protocol maintain the values as shown below and choose Next.


11. Choose Save.

10.11 Configuration to send attachments from SAP Hybris Cloud for Customer to SAP ERP

1. Select Object Type as All and Object Name as ATTACHMENTFOLDERREPLICATIONRE1 and choose Search. Select the hyperlink in the result list.
2. Under Configurations, choose Create Service.

3. On Service and Binding Name provide Service Name, Description, and Binding Name. Choose Next.

5. Choose Next.

7. Service definition is created and binding is generated.

8. Choose Back.

10.12 Define Logical System

1. Open one of the communication arrangements previously created.

2. Select the communication arrangement and click Edit.

3. The logical system name is the “My System” field. Right click in the field and click Copy.
4. Call transaction BD54 on SAP ERP.

5. Create the logical system by clicking New Entries.

6. Enter the logical system name and a description.

7. Click Save
10.13 Define Number Intervals

10.13.1 Define Number Intervals for Customer Contacts

1. Call transaction SNUM, and enter the object PARTNER.

2. Click in Number Ranges.

3. Click on Change Intervals.

4. Create the intervals as shown as follows, using a number range that is available in the system.

10.13.2 Define Number Intervals for Customers

1. Call transaction SNUM and enter the object DEBITOR.
2. Click on Number Ranges.

3. Click on Change Intervals

4. Create the intervals as shown below, using a number range that is available in the system.

10.14 Configuration of Communication Arrangements

1. Under the tab Administrator, click in Communication Arrangements.
2. Create the following communication arrangements:

- Business Partner Replication from SAP ERP
- Business Partner Replication to SAP ERP
- Opportunity with Follow Up Business Transaction Document in External System
- Opportunity with Print Preview of Sales Document in ERP
- Opportunity with Sales Order Pricing in ERP
- Product Replication with Sales Data from External System
- Sales Document Query in ERP
- Sales Quote with Sales Order in ERP

3. For example, to create the CA for Product Replication, Click New.

Communication Arrangements

You can view, create, and edit communication arrangements between your company and customers or

4. Select the communication system and the code list mapping, and click Next.
5. Select the protocol “Web Service” and the required authentication method. For example, in the case shown below, User ID and Password are selected.

6. Edit the password of the service account by clicking “Edit Credentials”.

7. In the case of a communication agreement that has outbound communication, configure the outbound communication.
8. Click Next and then Finish.

10.15 **Configure MS Outlook/ Lotus Notes (Optional)**

1. Choose Work Center View:

<table>
<thead>
<tr>
<th>Work Center</th>
<th>BUSINESS CONFIGURATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>IMPLEMENTATION PROJECTS</td>
</tr>
</tbody>
</table>

2. Select First Implementation project.
3. Choose Edit Project Scope button.
4. In the Scoping step, maintain the following values and choose Next.
How to Configure Integration between SAP ERP and SAP Hybris Cloud for Customer using SAP Process Integration

1. In the Questions step, navigate using the following path.
6. Mark In Scope for below Elements

<table>
<thead>
<tr>
<th>Scoping Element L1</th>
<th>Scoping Element L2</th>
<th>Scoping Element L3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication and Information Exchange</td>
<td>People Collaboration, Intranet, and External Services</td>
<td>&lt;all&gt;</td>
</tr>
<tr>
<td>Communication and Information Exchange</td>
<td>Office and Desktop Integration</td>
<td>Microsoft Office Integration</td>
</tr>
<tr>
<td>Communication and Information Exchange</td>
<td>Office and Desktop Integration</td>
<td>Integration with Local E-Mail Applications</td>
</tr>
</tbody>
</table>

5. Choose Finish to complete the scoping.

10.16 Customize Business role with Forecast and Reports (Optional)

1. Navigate to below work center.

<table>
<thead>
<tr>
<th>Work Center</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMINISTRATOR</td>
<td>GENERAL SETTINGS</td>
</tr>
</tbody>
</table>

2. Select the Business role SALES_ROLE (Sales Rep).
3. Choose the tab WORK CENTER AND VIEW ASSIGNMENTS.
4. Select below assignment.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Work Center/View ID</th>
<th>Work Center/View Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>WORK CENTER AND VIEW ASSIGNMENTS</td>
<td>COD_FORECAST_WCVIEW</td>
<td>Sales -&gt; Forecasts</td>
</tr>
<tr>
<td>WORK CENTER AND VIEW ASSIGNMENTS</td>
<td>COD_ANALYSIS</td>
<td>Analysis</td>
</tr>
</tbody>
</table>

5. Save and close the business roles page.

10.17 Configure Single Sign-On (Optional)

Pre-Requisites

1. Identity Provider like SAP NetWeaver Identity Management or SAP NetWeaver Single-Sign-On (SAP NetWeaver SSO) must have been installed in the system landscape.
2. Identity Provider configuration is already complete in the SAP NetWeaver Application Server (AS) Java.
3. Meta Data XML file of the Identity Provider system is already available with you.
4. Service Provider like SAP Hybris Cloud for Customer system is added as a trusted provider in the IDP and vice versa.
5. Identity Provider's certificate is stored in SAP Hybris Cloud for Customer system, in STRUST transaction.
6. SAP Hybris Cloud for Customer system's certificate is added to the Key Storage of the Identity Provider system.

Disclaimer

Pre-Requisites and Procedure may vary depend on your Identity Provider and the configurations done in the Identity Provider.

Procedure

1. Navigate to the following Work Center View.
2. Choose My System.
3. Under General ➔ Download Metadata, depending on the type of metadata acceptable to your identity provider, choose either of the following:
4. SP Metadata (Service Provider Metadata)
5. STS Metadata (Security Token Service Metadata)
6. Save the XML file to your local work space for upload into the Identity Provider.
8. For the field URL Sent to Employee, Choose Automatic Selection.
9. Choose Identity Provider tab and then Choose "New Identity Provider"
10. Upload the metadata XML file that you have downloaded from your Identity Provider system. By importing the metadata the system automatically uploads the required signature certificate and encryption certificate.
11. Choose Activate Single Sign-On and then Choose Save for saving the changes.
12. Confirm the pop up window by choosing OK.